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1.The cabinet

1.1. Cabinet panels

white MDF (medium density fiberboard) OR

MATERIAL:
white MCP (melamine coated particleboard)
NET WEIGHT: circa 120 kgs
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The panels will be referred to as A, B, C, D and E in the assembly instructions.



1.2. Materials and tools

NOTE: Some of the materials are only examples, so they can be replaced with similar products.

tapWall 65” ‘Quantity ‘Image
Computer (DELL) 1 Image
Computer power cord 1 Image
Ethernet cable (5m) 1 Image
Mini keyboard 1 Image
TV screen 65” 1 Image
Tempered glass 65” 1 Image
HDMI to Display cable 1 Image
Power extension cord: 5 outlets with switch, 1.8 m 1 Image
Power extension cord: 1 outlet, 5 m 1 Image
Circuit board 1 Image
Arduino 1 Image
IR cords and LEDs 1 Image
USB data cable 1 Image
USB data cable mini 1 Image
Reset button and cord 1 Image
IR frame 1

tapWall cabinet 1

tapWall logo 1 Image
Steel corner brace 25 Image
Steel corner brace (35x50mm) 10 Image
Screw (12mm) (antenna holder) 1 Image
Screw (15mm) 100 Image
Screw (45mm) 12 Image
Instruction manual and retractable reel holder 1 Image Image
Double-sided tape 1 Image
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https://www.dropbox.com/s/1mdwis2824a4odb/Dell_computer.jpg?dl=0
https://www.dropbox.com/s/rdm4j61xrcz2jy4/PC_power_cord.jpg?dl=0
https://www.dropbox.com/s/hhxceirf2jesx2n/ethernet_cable.jpg?dl=0
https://www.dropbox.com/s/3wbkgle7bqrcac3/wireless_keyboard.jpg?dl=0
https://www.dropbox.com/s/fztn6x5srsw19tq/TV%2065.jpg?dl=0
https://www.dropbox.com/s/jj7c6uw5osw6grw/Lasi%2065.jpg?dl=0
https://www.dropbox.com/s/jnheu0dj6fsiwon/HDMItoDisplay_cable.jpg?dl=0
https://www.dropbox.com/s/hrbcp63var5htwa/power_extension_cord_5outlets_switch.jpg?dl=0
https://www.dropbox.com/s/qk35qwywq6qwn0x/power_extension_cord_1outlet.jpg?dl=0
https://www.dropbox.com/s/zklse1jyesarvpg/Arduino_circuitboard.jpg?dl=0
https://www.dropbox.com/s/7n82st80deixt3a/Arduino_package.jpg?dl=0
https://www.dropbox.com/s/3exj2gyrlbugdeu/LEDs.jpg?dl=0
https://www.dropbox.com/s/owcuyqgy1kgf6tm/USB_data_cable.jpg?dl=0
https://www.dropbox.com/s/eg6kck5leg6z8z4/USB_mini_cable.jpg?dl=0
https://www.dropbox.com/s/3wgzffr8t8g0a3n/reset_button.jpg?dl=0
https://www.dropbox.com/s/v53x1lnygioprnu/iWall_logo.jpg?dl=0
https://www.dropbox.com/s/6omc5zqcqajhoid/peltikulma.jpg?dl=0
https://www.dropbox.com/s/wnx1bp9gm7ihkj3/steel_corner_brace.jpg?dl=0
https://www.dropbox.com/s/ef6k18p4rcdq7ub/screw_12mm.jpg?dl=0
https://www.dropbox.com/s/7lc1pdbxfbygr89/screw_15mm.jpg?dl=0
https://www.dropbox.com/s/dcvxox4houuab6d/screw_40mm.jpg?dl=0
https://www.dropbox.com/s/mj3jssyg267jcj1/intruction_manual_laminated.jpg?dl=0
https://www.dropbox.com/s/fyh2zd7spa50ku8/retractable_reel_holder.jpg?dl=0
https://www.dropbox.com/s/j0l96pup6x96149/double_sided_tape.jpg?dl=0
https://www.dropbox.com/s/q6g1w8gm4sxtwl9/screw_hole_stickers.jpg?dl=0

Installation tools and materials

Tools Quantity Example

Cordless drill/driver 1 Image
PZ2-bit 1 Image
Impact drill 1 Image
Glue gun 1

Jigsaw / saw 1 Image
Stone drill bit 8mm 1 Image
Wood drill bit 8mm 1 Image
Wood drill bit 3,5mm 1 Image
Wood drill bit 13 mm 1

Scissors 1 Image
Knife 1 Image
Utility knife 1 Image
Tape measure (3 m) 1 Image
A piece of felt (for attaching the logo) 1 Image
Screwdrivers (cross point and flat tip) 2| Image Image
Microfiber cloth 1 Image
Detergent 1 Image
Materials Quantity Example
Expansion wall anchor OR 4 Image
Sleeve-type hollow wall anchor 4 Image
Steel corner brace (35x50mm) 2 Image
Screws (70 mm) 8 Image
Reinforced duct tape 1 Image
Double-sided tape 1 Image
Painter’s tape 1 Image
Cable tie 5 Image
Cable casing 10 Image



https://www.dropbox.com/s/q5puhvozoq65932/cordless_drill_driver.jpg?dl=0
https://www.dropbox.com/s/ehdya4ja263fyld/PZ2_bit.jpg?dl=0
https://www.dropbox.com/s/xsnz245j7m608tr/impact_drill.jpg?dl=0
https://www.dropbox.com/s/869ox9y0gyd61y1/jigsaw.jpg?dl=0
https://www.dropbox.com/s/6kjf52ftlfg3itz/stone_drill_bit_8mm.jpg?dl=0
https://www.dropbox.com/s/rz6lqgp5bga4xc7/wood_drill_bit_8mm.jpg?dl=0
https://www.dropbox.com/s/q3pzq7vymopu2zs/wood_drill_bit_3mm.jpg?dl=0
https://www.dropbox.com/s/u17s5hemo8ik9iv/scissors.jpg?dl=0
https://www.dropbox.com/s/s2eo8a2d6gqyso0/knife.jpg?dl=0
https://www.dropbox.com/s/yhsxpkpbnutbbev/utility_knife.jpg?dl=0
https://www.dropbox.com/s/yhsxpkpbnutbbev/utility_knife.jpg?dl=0
https://www.dropbox.com/s/qh5ttrsn1gbe4tn/pieceof_felt.jpg?dl=0
https://www.dropbox.com/s/619u2pzybw5zp9g/screwdriver_crosspoint.jpg?dl=0
https://www.dropbox.com/s/d02v7hdj02e7nd3/screwdriver_flattip.jpg?dl=0
https://www.dropbox.com/s/g697n31wa7nklml/microfiber_cloth.jpg?dl=0
https://www.dropbox.com/s/kl2292jqhyl6igw/detergent.jpg?dl=0
https://www.dropbox.com/s/n44pn95hr9mdf7v/expansion_wall_anchor.jpg?dl=0
https://www.dropbox.com/s/0oxxr0ihvu2f5jw/sleevetype_hollow_wall_anchor.jpg?dl=0
https://www.dropbox.com/s/wnx1bp9gm7ihkj3/steel_corner_brace.jpg?dl=0
https://www.dropbox.com/s/awrgds4e6ezh585/screw_70mm.jpg?dl=0
https://www.dropbox.com/s/qvndmc2u5024jwl/reinforced_duct_tape.jpg?dl=0
https://www.dropbox.com/s/j0l96pup6x96149/double_sided_tape.jpg?dl=0
https://www.dropbox.com/s/3oyjja4lh3thx8r/painters_tape.jpg?dl=0
https://www.dropbox.com/s/247d2qrt7ioclwg/cable_tie.jpg?dl=0
https://www.dropbox.com/s/dyvxrsbsycn5i87/cable_casing.jpg?dl=0

We also recommend having the following spare parts during installation.

Spare parts Quantity

HDMI to Display cable 2
Internet cable 1
Steel corner brace X
Screws X

Arduino and circuit
board 1

Mini keyboard 1

IR frame 1




1.3. Cabinet assembly
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Assemble the cabinet on a flat and smooth surface, so that the connections are on the same

level.

Double-check all the cabinet edges that will
be against the floor. If they are not even, the
finished cabinet won't be stable and may

wobble.

Pictured on the right: The edges of the
cabinet that will be touching the floor once

the cabinet is finished.




Panels are attached to each other with steel corner braces (use 15 mm screws with them). Set
panels B and C on the assembly surface and place panels E between them to measure the

correct space for the TV hole.

Measure and mark the places where the three shelves (3 pcs of panel D) will be installed.

The bottom shelf: The panel should be installed about 20 cm from the bottom of the panel B.
The middle shelf: Measure the height of the TV screen’s bottom frame and the thickness of the
panel D. Add up the measurements and set the shelf that much below the TV hole. The panel is
attached with steel corner braces (35x50 mm) because of the weight of the TV and glass.

The top shelf: Measure the height of the glass and place the panel so that the glass fits between

it and the middle shelf (leave a 0,5 cm gap).

Set the panels A against the sides of the panels B and C and attach them with steel corner
braces: make sure that the bottoms of the panels A and B are on the same level (to prevent the
cabinet from wobbling once upright). Make sure that the shelves are horizontal in both width and

depth dimensions. Two of the D panels will be attached later, after the glass has been installed.

Panels E are easier to attach once the cabinet has been lifted to its upright position. They are

attached with 40 mm screws through the A panels. Drill small holes for the screws, so that the

screws won't cause protrusions in the panels. Cover the screw holes with screw hole stickers.
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2. Installation of the devices

Please bear in mind that the pictures are of a finished product.

Before finishing the cabinet, it is time to install the IR frame and glass. The IR frame, glass and
TV are placed inside the cabinet in the following order:

1) IR frame

2) Glass

3) The last two panels of the cabinet
) TV

N

2.1. IR frame

The IR frame consists of four parts. The ends of each part are marked with A, B, C or D.
Connect the ends with matching letters (A to A, B to B). The frame is assembled by pushing the
connectors together and screwing the fastening screws and covers in their place.

Pictured: The corner of the IR frame with “A” ends. The side with screws will be facing the back
of the cabinet.

The side of the IR frame that goes against the cabinet has “front” written on it: place the
double-sided tape to it and then press the IR frame against the cabinet’'s TV hole from inside.



Pictured: the tapWall cabinet from behind, the red lines represent the IR frame.



2.2. Glass

Tape the edges of the glass with double-sided tape. Then press it gently against the IR frame.

Pictured: The IR frame and glass installed against the cabinet’s TV hole from inside.

Pictured: The IR frame’s USB cable. It should be against the side of the cabinet, so that the TV
is easier to place.



2.3. Finishing the cabinet

The double-sided tapes aren’t enough: to prevent the IR frame and glass from moving, two
panels are installed to secure them. First, one panel is attached against the IR frame and glass
to support it from the bottom. Screw the panel to the one below it (use 45 mm screws).

Pictured: The new panel holding the IR frame and glass to the cabinet’'s TV hole.

Pictured: The two lower panels attached to each other.



Another panel is attached with 45 mm screws to the top of the TV hole, so that it will too support
the IR frame and glass against the cabinet.

Pictured: The tapWall cabinet viewed from “inside” or behind.



24. TV

The IR frame and glass are now properly secured, which means the TV can be installed next.
Before attaching it, make sure that the TV is centered horizontally. The TV is attached to the
cabinet panels with four steel corner plates, two down and two up. Insert the screws slightly
slanted to push the TV against the glass.

\

Pictured: A steel corner plate attached to the bottom panel. DO NOT SCREW THE STEEL
CORNER PLATE TO THE TV.



2.5. Power switch, ARDUINO and PC

The power extension cord with switch is placed on the topmost shelf and attached to the panel
C so that it is possible to press the switch. Reset-button is attached near the power extension
cord inside the cabinet with a steel corner brace.

Pictured: The power extension cord on the left and the reset button on the right.

Arduino is installed to the panel B inside the
cabinet, between the TV and computer.
LED is taped to the shelf holding the TV
near the IR receiver. Two usb cables are
used to connect the Arduino: one to the TV,
the other to the computer.

Pictured on the right: the Arduino
connections
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Pictured: The TV’s cables: it should have one HDMI cable and one usb cable.

The computer is set on the lowest shelf. It is not necessary to attach the computer to the front
panel (B), but if you wish to do so, we recommend doing it the same way the TV is attached
(explained earlier in this document).

Connect the following to the computer:
- HDMI cable

- IR frame’s USB cable

- Arduino’s USB cable

- ethernet cable

- mini keyboard’s receiver

Pictured on the right: the computer
connections.




3. TV and PC settings

3.1. TV settings

The screen resolution should be FULL. Remove the automatic shutdown (automatic TV OFF ->

Never). Set the sound volume to an appropriate level (10-20).

3.2. Screen settings

Desktop -> Mouse right-click -> Display Settings

View >
Sort by >
Refresh

Paste
Paste shortcut
Undo Rename Ctrl+Z

&3 Graphics Properties...

Graphics Options o5
@] SVN Checkout...
4 TortoiseSVN >

3 Display settings
B Personalize

Change the size of text, apps, and other items: 100%

Advanced display setting -> Resolution -> 3840 x 2160



Display adapter properties:
-> Monitor
-> Screen refresh rate -> 60Hz (if there are problems, change this to 59Hz)

-> Adapter -> Properties
-> Driver
-> Update Driver
-> Search automatically for updated driver software

3.3. Arduino settings

Open Arduino IDE: Windows menu -> Arduino
Verify the correct port setting
Tools -> Ports -> Selected COM (Arduino Leonardo)

&9 sketch_may23a | Arduino 1.8.2 - =] X
File Edit Sketch Toels Help

IE Auto Format Ctrl+T
Archive Sketch
sketen-mayze: Fix Enceding & Reload
void setup() | Serial Monitor Ctrl+ Shift+ M A
£y Frei
f4OBEEYEUE ool Plotter Ctrl+ Shift+ L
} WiFi101 Firmware Updater
void loop() { Board: "Arduing/Genuine Una" >
l t your| |
£/ BEE YEREE ot “COMA (Arduing Leonardo)” ! Serialports
B
i Get Board Info com3
P "AVRISP mikll" b Ciey
rogrammer: m 4
= " COM4 (Arduino Leonardo)
Burn Bootloader 5= |

Open Serial Monitor: Tools -> Serial Monitor (alternatively, press CTRL+shift+M)
- Write on the command line: ?
- Choose the command that correlates with the installed TVS (for example: Samsung -> SA).

Write it on the command line and press Enter.



5 COM4 (Arduin

Command line ¢~

| serd

- more debug print
Uncomment '#define QUICK DBG' if you want to debug this system more quickly (commands are sent with faster interval)

IR Controller usage

Select TV commands

SA (= SAMSUNG)
S0 (= SONY)

e TV selection options

FI (= FINLUX)

Supported commands

pWI? - Check every TVs power from USB

fw? - Prints firmware version

1 - Turns on TV and sets HDMI1 source channel
EWD - Turns TV on or off (use command 'pwr?' first to check TVs power)
up - Move up

down - Move down

left - Move left

right - Move right

ok - CE/Enter

source - Select source channel

back - Move back

Exit Arduino IDE (Alt + F4)

Open File explorer (Windows + E) and go to the build-folder (C:\Immersive_wall\Build\). Check

from the config-file that the Arduino port is correct, meaning it is the same number as it was in

the Arduino IDE port setting. Correct the number or change 'arduino find' to 'false’'.

I' & [ = | Build
Home Share View

o v h » This PC » Im@rsiveWall (C:) » Immersive_Wall » Build v O
Ly MName Type Size
ik s LR T
B Deskiop + File folder
File folder
‘_'D‘}""”'“ds 7 171008 JSON File 1KB
2 JSON File 1KB
[=] Pictures * 3 26420181333 Text Document 1KB
@ Immersive W # ﬂ Facelracrrrate 26.1.2018 10.46 Application extens... 10401 KB
| — [ EaraTeacklih Al 2619018 1046 oot 1NIEKE

Search

j config - Notepad

File Edit

u\\IThMeniExe” , "comPort™: "COMA™, "ig/iel ist™: [ "ProcessChecker”, "updater”, "launch "arduinoFound”:true,"K




3.4. Internet connection

Wired Internet connection: Plug in the ethernet-cable and the computer will automatically create

the Internet connection.

Wireless Internet connection: Choose the correct connection from the Network menu (on the

right in the Windows taskbar). Check the 'Connect automatically' setting and press 'Connect'.

E 24GHZ

onnected, secured

» Connect automatically

Connect

Inteno-4EAA

Se d

Inteno 83
Secured

Inteno-D80A

[ ] =
Sectred

o

Airplane mode

116
£ 22018

Write the network's password and press 'Enter'. Choose 'No' in the next part and the connection

is created. The connection is successful, when it says 'connected' under the network's name.



3.5. Restarting and testing

Recheck that the sound volume in the computer is 100 (from the Window taskbar's right side)

and that the sound volume is appropriate in the TV (10-20).

Restart Windows and the tapWall software will start automatically. Make sure that the games

start and they are playable.

Test the reset-button by holding the reset-button down for 2-3 seconds, which should cause the

computer to restart.

Test the TV's auto-start by shutting them down with the TV controller. Arduino will start them

automatically in a moment.



4. Finishing touches

5.1. Logo

The tapWall logo should be centered horizontally on the front of the cabinet (panel B). Vertically
the logo should be 10 cm below the lowest edge of the TV hole. Use a piece of felt to apply the

logo to the cabinet.

V//A
é/
tapWall

Pictured: tapWall installation with the logo attached correctly



5.2. Attaching the cabinet to the installation area

tapWall MUST be securely installed against a wall. CSE Entertainment can't be held
responsible for incorrectly installed tapWalls. The finished product is front-heavy, which means it
has to be secured robustly to prevent it from falling or moving. The product is usually attached
from the tops of the side panels (C) to a wall. Use steel corner braces (35x50 mm) and

expansion wall anchors or sleeve-type hollow wall anchors depending on the wall type.

5.3. Installation checklist

Always use the installation checklist to minimize problems.

Before tapWall is attached to a wall:

Internet connection

Game updates

PC and TV service tags and mac

Test the reset button

Test the power switch (on the extension cord)

TV screen’s auto-start

IR frame’s installation

Test the IR frame

TV settings

Volume control

Secure the cords and cables with tape




After tapWall has been attached to a wall:

Automatic shutdown

Attach the instruction manual to the back of the cabinet

Check the logo

Test the games

Hand over the keyboard and TV controller to the customer




